xHREM™
(WinHREM™/MacHREM™)

High Resolution Electron Microscope
Simulation Suite

User's Guide




Contents
Getting Started

B [ntroduction
B Before using xHREM™

B [nstallation
Installing xHREM™
Installing User Key Driver
Installing User Key

B Let's Start Tutorials
Scattering Amplitude Calculation
Image Intensity Calculation
EM Image Display
Diffraction Spot Pattern Display

B Topics
How to handle Non-periodic (Non-crystal) Model
Model Potential and Wave-function Display
Diffraction Intensity Quantification
Image Intensity Quantification
Model 3D display
TDS Absorption
Data Sharing using CIF File
Crystal Setting Selection
Static Diffuse Scattering calculation
Numerical Data Output using ImageBMP
Close Multiple Bitmap Windows

xHREM User’s Guide 2



Application

m Let's attack your own problem
Steps to create a New Data
Setting up Preferences
Creating Your Template WORKSHEET

MultiGUI Reference
ImageGUI Reference
DFOutGUI Reference
ImageBMP Reference
SpotBMP Reference

Appendix
m Blank WORKSHEET

FAQ (in preparation)
B About Dynamical Scattering Calculation

(MUItIGUI)
B About Image Calculation (ImageGUI)
B About Scattering Intensity Output

(DFOutGUI)

Support/Update
Email: support@hremresearch.com
WEB: www.hremresearch.com

xHREM User’s Guide



Getting Started

In this chapter

we explain the concept of xHREM™

and how to install them.

Then, you will learn how to use xHREM™
by using the attached examples.

H Introduction

High Resolution Electron Microscopy (HREM) becomes an indispensable tool
for understanding material properties or evaluating new materials at the level of
atomic resolution. Due to increased demands for research and development of
the new materials, an image simulation acquires more importance than ever

xHREM™ (WinHREM™ /MacHREM™ ) is a suite of the high-resolution
electron microscope image simulation programs that will run on Windows or Mac

Concept of xHREM™

User Friendly Graphical Interface

xHREM™ employs user friendly Data Generation Utilities based on the
Graphical User Interface for Windows or Mac OS.

xHREM™ is general-purpose software that can be used to simulate all
the images expected from any crystal systems, defect structures and
interfaces. Although data generation for such general-purpose software
normally becomes complex, a novice user can easily generate his/her data
by wusing the graphical Data Generation Utilities with minimum
requirements for the special knowledge.

Reliable and Efficient Algorithm

Since electron microscope 1images critically depend on an
electron-specimen interaction as well as aberrations of image forming lenses,
the treatment of scattering based on dynamical theory and the treatment of
aberration based on wave-optical theory are mandatory.

xHREM™ emerges from the HREM image simulation programs based
on FFT multislice technique developed at Arizona State University, USA
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(see References). This is one of the most reliable and efficient HREM
image simulation programs.

High Quality Image Output

Numerical data such as projected potential, wave function propagating the
specimen, simulated image intensities could be printed as high-quality gray
scale maps (Bitmap) by using Output Graphic Utilities. Numerical value
of each pixel of the gray scale can be exported for further analysis with
other software.

Extensions and Optimized Computation
There are two extensions for CBED (Convergent Beam Electron
Diffraction) simulation and high-resolution STEM image simulation.

xHREM, CBED Extension and STEM Extension support a multi-core
CPU, and the execution speed is optimized by using Intel’s Math Kernel
Library (MKL).

Especially, the STEM Extension supports GPGPU (General-purpose
computing on Graphic Processing Unit) and can speed up calculations by
more than 10 times compared to CPU processing. For further details,
consult the FAQ and the STEM Extension manual.

Features of xHREM ™

Efficient algorithm based on Fast Fourier Transform (FFT)

Applicable to any crystal systems and symmetries for an arbitrary
beam direction

Applicable to defects, interfaces and artificial supper-lattices
Treatment of partial coherency based on the transmission
cross-coefficient

Coherent Convergent Beam Electron Diffraction (Option: CBED
Extension)

High resolution STEM image simulation including ADF, ABF and DPC
images (Option: STEM Extension)

Steps for Image Simulation with xHREM™

xHREM™ consists of three graphical user interfaces (GUI) for scattering
calculation, image intensity calculation and scattering intensity output.
There are also other utilities for half-tone (gray-scale) image outputs. Even
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a novice user can easily generate input data satisfying the format required by
the calculation programs, and then execute calculations. High quality
simulated images are easily obtained by using the gray-scale output utilities.

Each GUI uses a window, called WORKSHEET, to assist the user to fill out
the necessary data. When saving (Save or Save As...) the input data in the
WORKSHEET, the GUI converts the WORKSHEET data into the input
data required by the calculation program. Actual calculation is easily
performed from the menu command (Execute) by using the converted data.

To get gray-scale microscope images do the followings:

1. Generate a required data for scattering calculation by using the
graphical user interface called MultiGUI, and then perform
calculation from Execute command of the File menu.

2. Generate a required data for image calculation by using the
graphical user interface called ImageGUI, and then perform
calculation from Execute command of the File menu.

3. Obtain gray-scale images from the calculated images by using
the utility called ImageBMP. The output gray-scale images may
be arranged into a table layout (Image Tableau) as functions of
thickness and defocus.

References
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Acta Cryst. A33 (1977) 740-749.

K. Ishizuka: Contrast Transfer of Crystal Images in TEM, Ultramicroscopy 5 (1980) 55-65

K. Ishizuka: Multislice Formula for Inclined lllumination, Acta Cryst. A38 (1982) 773-779.

K. Ishizuka: A practical approach for STEM image simulation based on the FFT multislice
method, Ultramicroscopy 90 (2001) 71-83.

K. Ishizuka: Prospects of atomic resolution imaging with an aberration-corrected STEM, J.
Electron Microsc. 50 (2001) 291-305.

B Before using xHREM™

If you are not familiar with routine operations of Windows/Mac OS such as
a clicking, double-clicking or dragging the mouse, a menu selection, a file
open/close procedure and so on, please consult the user's manual come with your
computer for getting acquainted with Window GUI before using xHREM™ .
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H |nstallation

Installing for Windows

xHREM (WinHREM™) is distributed on-line. The software should be
installed into the hard disk by following the standard procedure below.

Unzip the downloaded file, and execute 'Setup.exe' by double-clicking it. It
is advised that the WinHREM programs are installed into the directory
named 'XHREM' under /Program FilessHREM Research as instructed by the
installer.

The structure of the 'xXHREM' folder on the hard disk will be the one shown
below. Sample data will be installed in the 'xHREM Data' folder under your
‘My Documents’ directory.

The installer will register WinHREM application icons (shortcuts) under
'XHREM' on the Start menu.

Installing for Mac OS X

xHREM (MacHREM™) is distributed on-line. The software should be
installed into the hard disk by following the standard procedure below.

Open a disk image file (.dmg) that you have downloaded. Then, in order to
install the program, open xXHREM.pkg and select xHREM (English) or
xHREM (Japanese). Next, install the data using Data.pkg.

The structure of the 'xHREM' folder on the hard disk will be the one shown
below.

The structure of xHREM program folder

Utilities : GUI, Output Utilities
Programs  : Programs for numerical calculation
Resources : Resources used by Ultilities

Documents : Manuals
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(Windows) Installing User Key Driver

Installing User Key Driver
NOTE: Disconnect the USB key.

Launch “HASPUserSetup.exe,” and follow the instructions to install the user
key driver.

Installing User Key

Simply plug your USB key into an USB port.

If your user key is not recognized, the software will run as a demonstration
version.

(Mac OS) Installing User Key Driver

Installing User Key Driver

NOTE: Disconnect the USB key.

Open the disk image file (.dmg) that you have downloaded, and follow the
instructions to install the user key driver.

Installing User Key

Simply plug your USB key into an USB port.

If your user key is not recognized, the software will run as a demonstration
version.

How to evaluate xHREM without a user key (v4.1 or later)

When a user key is not recognized, xHREM will run as a demonstration
version. Then, you cannot calculate dynamical scattering using MultiGUI,
nor TEM images using Image GUI. However, you can get an experience on
how to create an input data using the graphical user interface. Furthermore,
for the sample data you can go through the steps for image simulation using
the pre-calculated data that are included in the installer.
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M | et's Start Tutorials

How to use GUI for Data Input

By using three graphic user interfaces (GUIs), the required data for numerical
calculations are prepared by filling the window called WORKSHEET. Each GUI
has File, Edit and Help menus. Please consult the references for the details of
each menu.

Sample Data

Two sets of data are provided within the Data folder for exercises. They
are a tin oxide (SnO,) and a complex oxide of tungsten and niobium
(WNb5s0g9), and their sample name are SnO2 and WNbO, respectively.
We use SnO2 here as an example, but the same steps can be applied to
WNDO. Please play with WnbO by yourself later.

At first we calculate scatting amplitudes, and then calculate image
intensities. The gray-scale images or diffraction patterns will be obtained
from the image intensities of the scatting amplitudes.

When you use xHREM as a demonstration version, you cannot save an
input data nor execute actual calculation. However, for the sample data you
can go through the steps for image simulation using the pre-calculated data.

Scattering Amplitude calculation

At first, let's prepare the data required for the scatting amplitude calculation
(When you use XHREM as a demonstration version, you can go through the
steps for image simulation, although you cannot save an input data nor
execute actual calculation.):

1. Launch MultiGUI.

Please consult your computer manual about how to launch an
application.

2. Choose "Open..." from the File menu to browse the sample data, and select
“Sn0O2.WS1”.

Please consult your computer manual about how to select a file.
The WORKSHEET for data input will appear.

TIPS: The lower part of the WORKSHEET can be accessed by sliding
the window or by expanding the display area.
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r N
@D SnO2 (Crystal) - MultiGUI = = 28 =|

File Edit Help

Title: Sn0O2
Cell Parameters Symmetry Operation
a 4?3? Angstrom ]35 P4(2)}mnm
b 4737 Anestrom Elements 8
c 3.186 Anestrom
a0 Atom Parameters =
o
-
, 90 No. of Atoms 2
Overall Thermal Factor 1
Calculation Control
Phase Grating (PG) Setup Acc Voltage 100 Ky

Dividing a cell into 1 v slices
Overwrite the PG, if exist
Multislice Calculation

Ihcident Beam Direction:
al b 0 c 1

. Up to 20 slices Unitary test:
@ Start from beginning T

Every 10 slices
| PG Sequence |

() Continue/Resume

A

In this WORKSHEET, appropriate data is already filled out. Here,
let's create a new data set by changing the Title entry:

Input a new title "SnO2 test calculation" in the Title field.
4. Choose "Save As..." from the File menu.

When you are using xHREM as a demonstration version, skip the steps
after this, since you cannot save an input data nor execute actual
calculation.

5. Save the new data as "SnO2test" in the save dialog appeared.
Please consult your computer manual about how to save your file.

TIPS: An extension "WS1' will be added automatically. Thus, you
may not need to specify the extension.

Next, we calculate the scattering amplitudes by using the data crested above:

6. Choose 'Execute Multislice' from File menu.
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File | Edit Help

New >
Open... Ctrl+0
Close Ctrl+w
Import CIF..

Export CIF...

Save Ctrl+S
Save As... Ctrl+Shift+S

Execute Multislice
Execute DIFFUSE
Execute CBED

Execute STEM

Exit

The program (multi.exe) that calculates the scattering amplitudes will
be launched, and the progress of calculation will be displayed on a
separate window. When an execution terminates normally, you will
see the message "Execution completed. Congratulations!"

Ml Sn02.WS1 Multislice

File Edit Help
~
0  UNITARY TEST AT 20 TH SLICE RANGE SUM ACCUM T
0.000 - 0.150 0.7923 0.7923
0.150 - 0.300 0.1784 0.97086
0.300 - 0.450 0.0225 0.9932
0.450 - 0.600 0.0043 0.9974
0.600 - 0.750 0.0017 0.99392
0.750 - 0.900 0.0008 0.9997
0.900 - 1.050 0.0001 0.9999
1.050 - 1.200 0.0001 1.0000
1.200 - 1.350 0.0000 1.0000
1.350 - 1.500 0.0000 1.0000
Execution completed. Congratulations! 7

NOTE: The progress window has the fundamental menus such as File
and Edit, and you can Save the content of the window from the File
menu.

TIPS: The program can be terminated even in the middle of calculation
by Exit command from the File menu or clicking the close button.

The progress window can be closed by Exit command from the File
menu or clicking the close.

7. To terminate MultiGUI, select 'Exit (Quit)' from the File menu.
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Image Intensity Calculation

The process for the image intensity calculation is similar with the scattering
amplitude calculation. Before this step, you must prepare the scattering
data (.DF) by using MultiGUI. (When you use xHREM as a demonstration
version, you can go through the steps for image simulation, although you
cannot save an input data nor execute actual calculation.)

1.

Launch ImageGUI.

NOTE: There is no WS2 file corresponding to the data name that we
have used for the MultiGUI, namely SnO2test. WS2. Thus, we will
create it using an existing data (SnO2.WS2). You may create a WS2
data from a scratch by using Default. WS2.

Choose “Open...” from File menu to browse the worksheet (\WS2), and select
SnO2.WS2 in the Data folder.

Please consult your computer manual about how to select a file.

NOTE: When you haven’t finished dynamical scattering calculation for
SnO2 data, you will get the following warning message. Then, press
“OK” and continue the steps.

r n

Corresponding dynamical scattering data file (SnO2.DF) and/or
the worksheet for MultiGUI (SnO2.WS1) do not exist in the same
folder. Although you may not be able to calculate the HREM
images, do you want to open this worksheet (SnO2.WS2)
anyway?

| OK H Cancel ’

The worksheet shown in the next page will be opened.

TIPS: The lower part of the WORKSHEET can be accessed by sliding
the window or by expanding the display area.

In this WORKSHEET, appropriate data is already filled out. Here,
let's create a new data set by changing the Dynamical Scattering Data:

Using “Browse” button, select the data set “SnO2test.DF”.

When you are using XHREM as a demonstration version, you do not
need to select SnO2test.DF. You can use a provided pre-calculated data
(SnO2.DF). When you use SnO2.WS2, SnO2.DF will be selected

automatically.
Input a new title "SnO2 test calculation" in the Title field.
Choose "Save As..." from the File menu.

When you are using xHREM as a demonstration version, skip the steps
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after this, since you cannot save an input data nor execute actual
calculation.

6. Save the new data as "SnO2test" in the save dialog appeared.

TIPS An extension "WS2' will be added automatically. Thus, you
may not need to specify the extension.

-
@ Sn02.WS2 - ImageGUI

=)

File Edit Help

Dynamical Scattering Data: Sn02

Title: Sn02

Optical Parameters

Spherical aberration coefficient (G3)
Fifth order Spherical aberration (C5)
Defocus spread

Beam convergence

Aperture radius inner 0
position a% 0
Zernike Phase Plate 00

' outer
b*

pai

Simulation Mode: @) First order(Envelope)

Specimen thicknesses (slice number):

10 20

Defocus values {Anestrom)

500 900

Qutput contral

Export Data for Gray Scale Map
Structure Factor

(Kinematical scale)

0.90

mm

0 mm

50 Angstrom
0.03 fBnestrom
0.2 fBnestrom
0

") Second order{TCC)

Optional Setup

Next, we calculate the image intensities by using the data crested above:

7. Choose 'Execute' from File menu.
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Edit Help

New
Open... Ctrl+0
Close Ctri+wW

1}

ave Ctrl+S

Save As... Ctrl+Shift+S

[

Execute

Exit

The program (Image.exe) that calculates the image intensities will be
launched, and the progress of calculation will be displayed on a separate
window. When an execution terminates normally, you will see the
message "Execution completed. Congratulations!"

NOTE: The progress window has the fundamental menus such as File
and Edit, and you can Save the content of the window from the File
menu.

TIPS: The program can be terminated even in the middle of calculation
by Exit command from the File menu or clicking the close button.

The progress window can be closed by Exit command from the File
menu or clicking the close.

8. To terminate ImageGUI, select 'Exit(Quit)' from the File menu.
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EM Image Display

Then, let's display gray-scale (half-tone) images that have been numerically
calculated for SnO2 by using ImageGUI.

At first, you have to launch a utility and select a numerical image data to be
displayed:

1.
2.

Launch ImageBMP.

A data selection dialog will be opened. Select SnO2test. AUX2 in the Data
folder. (A data file for image display calculated with ImageGUI has ".AUX2".)

When you are using XHREM as a demonstration version, you should
select a provided pre-calculated SnO2.AUX2, instead of SnO2test. AUX2.

The following window will be appeared.

g A
@ SnO2.AUX - xImageBMP Lo | o [t
File Edit Window Help
Title: Sn02|
Unit Cell
a: 4737 Angstrom b: 4737 Anestrom angle: 900
{ 32 points ) ( 32 points ) { cosine 0.000)
Digplay Ranee
a0 RESE b D > 1
Image Size Display Limit
Height: 58 pixels Low: Minimum
Width: 58 pixels High: Maximum
12 pixels/Angstrom
Image Selection | Reverse Contrast
Slice: [ 10 v] (| Atom Overlay
Defocus: [500 v]
Imaege Tableau Tableau Setup Generate |

Then, let's get some images.

3.

Click "Generate" in the right bottom of WORKSHEET.

After a few seconds, you may get a gray-scale image shown below.
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This is an image calculated for the conditions corresponding to a slice
and a defocus specified in the WORKSHEET. Specifically, Slice: 10;
Defocus: 500 A (under-focus); Display Range: (0<->1) x (0<->1).

Next, draw a wider gray-scale image extended over a few unit cells.
4. Change end-points (left input-boxes) of a and b of "Display Range" to two (2).
5. Click "Generate" as before.

You will get a gray-scale image of 2 x 2 unit cells as shown below.

6. You can save each gray-scale image by choosing "Save" or "Save As..."
from "File" menu, if you want to.

You can choose an image format in the dialog that will appear.

If you want to save a quantitative data (binary data) of the displayed
image, you can use "Export Data..." command (Please refer to
Topics/Numarical Data Output using ImageBMP).

You can also print each gray scale image by choosing "Print" from
"File" menu.

7. Close each Bitmap window by choosing "Close" from "File" menu.

If the gray-scale image has never been saved, a dialog for confirming
your action.

TIPS: You can avoid this confirmation dialog, when you close the
window while pressing the "Shift" key. When you want to close
multiple bitmap (BMP) windows, please consult the Topics “Close
Multiple Bitmap Windows.”
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8. To terminate ImageBMP, select "Exit (Quit)" from "File" menu.

NOTE: The default file name of an EM image is "Sample name_slice
number_defocus.bmp."

To obtain an image at other slice and/or defocus, select a slice number
and/or defocus value from the "Slice" and "Defocus" pull-down menus.
These pull-down menus show all possible selections on your data set.

Image Selection

Slice: |10 v |
Defocus: |20
Select
[[JImaee Tableau All_

When you choose “Select” from “Slice” or “Defocus” pull-down menu, you
will get a following dialog, where you can select the slices or defocuses that
you want to display.

Err A E
- 4 — -

[v]10 [v]20

b 0Kl [Oancel ]

TIPS: If you choose "All" or “Select” from "Slice" or “Defocus” pull-down
menu, EM images for all, or selected slices or defocus values will be
displayed in sequence.

TIPS: If you choose "All" or “Select” both from "Slice" and "Defocus”
pull-down menus, EM images for combinations of all, or selected slices and
defocus values will be displayed in sequence.

TIPS: If you click “Image Tableau™ check box, the selected images will be
displayed in a table layout in terms of Slice numbers and Defocus values.
In the example below, all the calculated images were displayed. You can
specify the way of layout of slices and defocuses as well as gaps between
each image in the dialog that will appear when you click “Tableau Setup”
button (see Application section for more details).
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Image Selection

Slice: | All v

Defocus: [AII v ]

[V]image Tableau: [ Tableau Setup ]

TIPS: If you select “Atom Overlay” check box, a colored circle specific for
each element will be drawn at each atom position as shown below. The
size of the circle and its color will be modified with a dialog that will appear
when you click “Setup" button.

NOTE: The gray-scale image can be printed out by using "Print" from "File
menu. The displayable gray levels depend on your printer specifications.
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Diffraction Spot Pattern Display

Here, let's display electron diffraction patterns for SnO2 by using calculated
scattering data with MultiGUI.

At first, you have to launch a utility and select a scattering data to be

displayed:
1. Launch SpotBMP.
2.

(A data file for image display has ".DF".)

A data selection dialog will be opened. Select SnO2test.DF in the Data folder.

When you are using XHREM as a demonstration version, you should
select a provided pre-calculated data, SnO2.DF, instead of SnO2test.DF.

A WORKSHEET for setting up display conditions will be appeared.

-
@ SnO2test.DF - SpotBMP =)
File Edit Window Help
Title: Sn02 test
Unit Cell
a 02111041 1/Angstrom b 02111041 1/Anestrom angle: 90.0
{ 32 points ) { 32 points ) { cosine 0.0000 )
Display Range
Radius: 1 1/Angstrom Resolution: 128 points/{ 1/Angstrom)
{upto 1) (Image Size : 256 pixel)
Display Setup Digplay Limit
Spot Shape: @ Disk () Peak Low: Minimum
Spot Radius: 10 points High: Maximum
V| Show Index Slice :
Image Selection | Reverse Contrast
Slice : [0 v
Type : [Log of Intengity v] Generate
A

Then, let's get some diffraction patterns.

3.
of WORKSHEET.

After setting the condition as shown above, click "Generate" in the right bottom

After a few seconds, you may get a gray-scale image shown below.

xHREM User’s Guide

19



. ' * .
4,204, 14,0
* * & * L) &
3J-3-3J-2-3J-1

ol oSt on o 2 2K

mﬁﬁ% ’m?---

-mfm-?-:l%m---
ot e oo " '

L/ L J L J L/ L/ L/
eI RE N M 2E gE

4. Next, uncheck the "Show Index" and select "Peak" from the "Spot Shape," then

Click "Generate. "

After a few seconds, you may get a gray-scale image shown below.

- | AEES

5. To terminate SpotBMP, select "Exit (Quit)" from "File" menu.
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B Topics

In this section some useful functions as well as advanced topics will be
introduced. It is not necessary to read through all the topics at the first time.
You may want to study each topic when you need to use it.

How to handle Non-periodic (Non-crystal) Model

xHREM intensively uses Fast Fourier transform that assumes a periodic
continuation. Therefore, in order to simulate a model without a periodicity
(non-periodic/non-crystal model), such as a nano-particle, we need a new
device. XHREM handles non-periodic model using a big artificial cell
(super-cell) that include the model. Here, a non-periodic model assumes that
a super-cell is arranged as a 2D crystal as shown below.

< Y

i //////

- -

< / - .

The model size will be automatically calculated from the atom coordinates
by the user interface. Furthermore, the model can be rotated to an arbitrary
direction by using the xModelView, and then a simulation for that direction
can be performed. In this case, the model size will be automatically
calculated by the xModelView.

xHREM provides a graphical user interface shown below to make it easy to
handle a non-periodic model.
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q ~
@ Untitled (Non-Crystal) - MultiGUI [ESR R
File Edit Help
Title:
Cell Parameters Symmetry Operation
Model Space Solect 1 P1
a 10 { no+ 10 ) Bnestrom
Edit Elements 1
b: 10 { 0o+ 10 ) Bnestrom
c |1 { 0o+ 1 ) Bnestrom Atom Parameters :
o 90
B 90 No. of Atoms 0
1 90 Overall Thermal Factor 0
Calculation Control
Phase Grating (PG) Setup Acc Voltage 100 Y
. . i < sl
Dividing a cell into slices Incident Beam Direction:
(V] Overwrite the PG, if exist - -
‘ all b (0 c |1
V| Multislice Calculation
. Upto 1 units LAl it
Q) Start from beginning Limit 099 ey o
) [ PG Sequence ’
") Gontinue/Resume
L A

The size of a super-cell can be defined by adding the Space to the Model
size. Alternatively, the Space will be calculated from the super-cell size, if it
is larger than the Model size. Here, the Space should be adjusted, so that any
virtual neighboring models do not affect the results of simulation.

In the case of a non-periodic model, a space group or symmetry operations
commonly used for a crystal model is not used. Furthermore, the lattice is
restricted to an orthogonal system, and all the angles are always 90 degree.

If a non-periodic model is generated using a super-cell, the simulation can
be performed in the same way as the crystal model. However, the size of a
super-cell of a non-periodic model is usually larger than the unit cell of a
crystal. Furthermore, all the phase grating will be differ each other, and the
number of the phase gratings becomes large.

Moreover, a calculation will be performed over only one super-cell (one
unit) along the z-direction, since there is no periodicity along the z-direction.
Thus, we can always use one (1) unit for the Up to parameter, even if the
super-cell is divided to any number of phase gratings, when you select Units
for the Thickness in the Preferences.
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Display Model Potentials or Wave-functions

Model potential distributions or wave-functions within the sample, which
were calculated with MultiGUI (multi.exe), will be displayed as gray-level
images by using ImageBMP.

To display them:

1.

3.

Execute a calculation with a check on corresponding “Export Data for Gray
Scale Map” in the “Output Control” section of MultiGUI.

The display data calculated with MultiGUI will be saved in a file with
“.AUXT1” extension.

Launch ImageBMP, and select a corresponding AUX1 file.

When you are using XHREM as a demonstration version, you should
select a provided pre-calculated data SnO2.AUXI.

The following window, which you have seen for microscope image
display, will be open. However, the “Image Selection” section is
different from that for the microscope images, since the potential
distributions and the wave-functions are saved as complex numbers.

Ml Sn02_AUX — xImace BMP

File Edit Window Help
Title: :775n02
Lhit Cell
a 4737 Angstrom b 4737 Angstrom anele: 00
{ 32 points } { 32 points ) { cosine 0.000 3
Display Range
a0 ] | b:[o | <> 1
Image Size DCisplay Limit
Height: 58 pixels Low: Minimum
Width: 58 pixels High: Maximum
(12 7‘ pixels/Angstrom
Image Selection [[]Reverse Constrast
(%) Potential: i 1] v
() Wave Function:
Digply Type: ‘ Amplitude v Generate

Setup display conditions and select what you want to display.
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Potential: You can specify a slice number (from 0 to 9) to be displayed, when
you have divided a unit cell into different slices up to ten (10).

Wave Function: Select a thickness (in slice number) to be displayed.

Show: Since the potential distributions and the wave-functions are saves as
complex numbers, you have to select a quantity to be displayed from the
following list:

Digply Type: VAmpIitude v

Amplitude
Intensity

Log of Intens iti
Real
Imaginary

4. Click “Generate” to create a gray scale image.
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Survey Diffraction Intensity

You can qualitatively compare dynamical diffraction intensities by
looking a gray scale display generated by SpotBMP. When you want
to compare the intensity quantitatively, you can use “DFOutGUI.”
(When you are using XHREM as a demonstration version, you can use a
provided pre-calculated data.)

To survey diffraction intensities (amplitudes), you have to prepare the data
as follows:

1. Launch DFOutGUI, and Choose “Open...” from File menu.

NOTE: There is no WS3 file corresponding to the data name that we
have used for the MultiGUI, namely SnO2test. WS3. We will create it
from now using an existing data. You may create a WS3 data from a
scratch by using Default. WS3.

2. Select Sn0O2.WS3 from the Data folder, when the open dialog appears.

NOTE: When you haven’t finished dynamical scattering calculation for
SnO2 data, you will get the following warning message. Then, press
“OK” and continue the steps.

g B

Corresponding dynamical scattering data file (SnO2.DF) does not exist in
the same folder. Although you may not be able to display scattering
data,do you want to Open this worksheet (SnO2.WS3) anyway?

L 4

The WORKSHEET shown in the next page will appear.

In this WORKSHEET, appropriate data is already filled out. Some
reflection indexes are already specified for each page. Here, let's
change Dynamical Scattering Data which has been calculated during
the tutorial.

3. Open “SnO2test.DF” from “Browse” button, which is placed in upper right.

When you are using XHREM as a demonstration version, you do not
need to select SnO2test.DF. You can use a provided pre-calculated data
(SnO2.DF). When you use SnO2.WS3, SnO2.DF will be selected
automatically.

4. Choose "Save As..." from the File menu.
5. Save the new data as "SnO2test" in the save dialog appeared.

TIPS: An extension '"WS3' will be added automatically. Thus, you
may not need to specify the extension.
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-
Sn02.WS3 - DFOutGUI

=)

File Edit Help
Dynamical Scattering Data:

Qutput Control
Ranee: @) all
1 {=>

Step: 1 slices

Indices of Reflections:

Sn02

20

Browse

Size  Height: 300 pixel

Width: 450

Draw

pixel

Resize

Page No

Index1

Index 2

Index 3

Index 4

SEEIEEE
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Index 5

Index 6
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Index7

) 51 'S Y1 (S Y 2 e

Index 8

Index 9

<| 1
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Next, we survey the image intensities by using the data saved above:

6. Click "Draw” button.

In the graphic chart the magnitude of amplitude is displayed in log scale

to display a wide range of data.
displayed between [-7t, +7].

On the other hand the phase is

You may note that this phase is shifted by

7/2 to be consistent with the phase of kinematical structure factor.

You can change the width and/or height of the graph using “Resize”.

r Y
@ Page0 L= |
File Edit Help
AMPLITUDE (LOG) PHASE Index
14— =3 - 1 1P . Pl e a0
L el < » @ . 0 1
L K] L o o«
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o o o ° ©0| ® 03
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o |o . . 00
11] < = 11 o -
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1 0 < 1600 <
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® o ° o o o
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2 ©- % 20 < -

xHREM User’s Guide

26



Survey image Intensity

Electron micrographs or wave-functions displayed by using ImageBMP will
be surveyed quantitatively as explained below. Intensity profile along the
specified line can be displayed and surveyed quantitatively.

Intensity on a gray scale image: When you move the mouse over a gray
scale image, intensity under a mouse point is displayed with its coordinates.

aEd

07799(002696,06870)

NOTE: An intensity value will not be displayed for an image created as
an “Image Tableau.”

Profile image: When you drag a mouse with SHIFT key down from the
starting point of a profile, a red line is drawn on the image. When you stop
dragging, intensity under the red line is displayed on a separate window

05649(03421,03711)
When you put a mouse on the line profile, intensity and its coordinates in
original image are displayed below the profile.

NOTE: A profile image will not be displayed for an image created as
an “Image Tableau.”
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3D Display of Atomic Model

Using a 3D display you can check your atomic model to be used by
MultiGUI. Here, we explain the 3D display by using a sample data of
SnO2.

To display an atomic model as a 3D image:

1. Launch MultiGUI.

2. Choose "Open..." from the File menu to browse the sample data, and select
“SnO2.WS1”.

The WORKSHEET for SnO2 will appeare.

3. Click “Model View” in the Option section at the very bottom of the
WORKSHEET.

Opticns

(_ceep | [ sTEm ] [ Model View |

TIPS: The lower part of the WORKSHEET can be accessed by sliding
the window or by expanding the display area.

Then, you will get a 3D display of the Atomic model:

'@ Sn02 o | B (S

File View Help

Projection Controk:

c

(a] [e) Crystal Setting [c:1(ab<) v |[ Close |

|

Under the regular setting the model is displayed as a projection along c-axis.
The direction of projection is easily changed by selecting “a, b or ¢” in the
tool bar.

TIPS: Tools in the tool bar (from left): Rotation, Back-and-forth movement,
In-plane movement, Perspective control and Projection directions.
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By adjusting a slider of the “Projection control” the model is displayed in
perspective drawing. The following show an example.

r@ Sn02 o | B )

Eile View Help

~

Projection Controt:

= @) (&) Crystal Setting [c1(abc) v|[ Close |

A

Crystal Setting (Crystal model): You can change the crystal setting of the
Preferences from here.

Projection Controk:
@ @ @ [ et

Use this orientation (Non-periodic model): By clicking this button, you
can simulate the model rotated to an arbitrary direction.

TIPS: The size and color of egch element, o o = < )
the range of the model to be displayed and
the scale of display can be modified in the ement Z’; |;’5 |
dialog that will appear when the View :: ﬂ——
Options of the View menu is selected. 7 b
Display Range
a 0 <--> 1
b 0 <--> 1
c 0 <--> 1
Scale
1
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Including TDS Absorption

You can include absorption of elastically scattered wave due to thermal
diffuse scattering (TDS) in your dynamical calculation. In this case,
however, thermal displacement parameter (temperature factor;
Debye-Waller factor) for each atom in your atomic model is required.
When you don’t know a corresponding parameter, an approximate value
may be specified.

To include TDS absorption in your dynamical calculation:
1. Launch MultiGUI
2. Choose “Preferences” from Edit menu.

3. Select “Weikenmeier-Kohl Scattering Factor” in “Atomic Scattering Factor”
section of the Preferences dialog, and check “Include TDS absorption.”

Atomic Scattering Factor

(O Mott Formula with Doyle-Turner X-ray Scattering Factor
() Weikenmeier-Koh| Scattering Factor [V]Including TDS Absorption

4 . Setup other parameters and execute “Multislice.”
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Data Sharing using CIF File

xHREM™ can read/write (Import/Export) a data with CIF (Crystallographic
Information File) format. Therefore, you can share crystal data (lattice
constants, Space group/Symmetry operations, Atomic positions etc.) with
other software.

Edit Help

New »
Open... Ctrl+0
Close Ctrl+w
Import CIF..

Export CIF...

Save Ctrl+S
Save As... Ctrl+Shift+S

Execute Multislice

Execute DIFFUSE
Execute CBED
Execute STEM
Exit

NOTE: The CIF data items handled by xHREM™: Lattice constants,
Space group (Symmetry operations), Atom species, Atom coordinates,
Thermal factor, Occupancy.

xHREM for Windows and Mac OS stores atomic model data such as atomic
positions with the same database format. Therefore, the atomic model
database can be freely shared between Windows and Mac OS.

NOTE: You can also share an atomic model data with other
applications by saving them as a text file using “Export” button on the
“Edit” window of “Atom Parameters” section of MultiGUI.
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Permutation of Crystal Axes

xHREM™ can take account of an incident surface effect into dynamical
calculation (K. Ishizuka: Multislice Formula for Inclined Illumination: Acta
Cryst. A38 (1982) 773-779). Therefore, an incident beam direction of
<hkO> that is parallel to the surface is forbidden.

However, when you neglect the incident surface effect (most of the
programs do not take into account the surface effect), you can
straightforwardly calculate for <hkO> incidence by using a capability of
permutation of crystal axes without changing a model data.

To permute the crystal axes, choose “Preferences” from Edit menu of
MultiGUI. Then, you may notice “Crystal Setting” on the upper right of
the Preferences window as shown below:

Crystal setting
@1 b, c)
Oob ca
(O, a b
ON b, a -
OV . b, -a)
OV (5 ¢ -b)

For example, in the case of <110> incidence we cannot use I (a.b.c) system,
since the index of the third axis (c-axis) is zero. However, indexes of both
a-axis and b-axis are not zero, and thus we can use either these axes for the
third axis. Therefore, we can choose one system from II, III, V or VI for
the <110> incidence. Contrary to this, in the case of <100> both indexes
of b- and c-axes are zero, and thus we cannot use both of them as the third
axis. Therefore, we can use either II or V system where a-axis is the third
axis.

NOTE: Neither the crystal axes nor symmetry operations are permuted
in the WORKSHEET of MultiGUI. Nevertheless, the selected crystal
system is used in calculation, and symmetry operations are transformed
accordingly. When you check the list output, you can verify the lattice
constants, atom parameters, and symmetry operations actually used in
calculation.
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Calculation of Static Diffuse Scattering

Since xHREM™ can handle up to 1,000,000 atoms, diffuse scattering due to
static disorder of atom positions can be estimated by using an atomic model
including static displacements of atom positions.

To calculate diffuse scattering due to static disorder:
1. Launch MultiGUI.
2. Input necessary data in the WORKSHEET as usual.

Using “Edit” dialog of “Atom Parameters” of MultiGUI, it may be
difficult to prepare a large atomic model including static displacements
of atom positions. Therefore, it may be convenient to read a text data
file of atomic model created separately by using “Import” capability.

3. Click “DIFFUSE” in the Option section at the very bottom of the WORKSHEET.

Options

DIFFUSE CBED STEM Model View

TIPS: The lower part of the WORKSHEET can be accessed by sliding
the window or by expanding the display area.

The following dialog will appear, where you can specify some output
controls specific to DIFFUSE calculation. Change controls as you
want, and Click “OK.”

W DIFFUSE A=

Output Contral

[ Numerical Map Linear v

Every |9 v‘ Slices

[VIiExport Data for Gray Scale Map:

Every |9 v‘ Slices

[ OK | | Cancel |

4. Save your data.

When you are using xHREM as a demonstration version, skip the steps
after this, since you cannot save an input data nor execute actual
calculation.

5. Choose “Execute DIFFUSE” from File menu.
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Edit Help

New »
Open... Ctrl+0
Close Ctrl+w
Import CIF...

Export CIF..

Save Ctrl+S
Save As... Ctrl+Shift+S

Execute Multislice
Execute DIFFUSE

The program (diffuse.exe) that calculates the diffuse scattering
amplitudes will be launched, and the progress of calculation will be
displayed on a separate window. When an execution terminates
normally, you will see the message “Execution completed.
Congratulations!”

NOTE: The progress window has the fundamental menus such as File
and Edit, and you can Save the content of the window from the File
menu.

TIPS: The program can be terminated even in the middle of calculation
by Exit command from the File menu or clicking the close button.

The progress window can be closed by Exit command from the File
menu or clicking the close.

6. To terminate MultiGUI, select "Exit (Quit)" from "File" menu.
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Display Diffuse Scattering Distribution

“ImageBMP” can be used to display diffuse scattering distributions.
Diffuse scattering data is saved in a file with “.ED” extension. (When
you are using XHREM as a demonstration version, you can use a
provided pre-calculated data.)

To display diffuse scattering patterns:
1. Launch ImageBMP.
2. Open a “.ED” file with an appropriate name.

When you are using XHREM as a demonstration version, you can use a
provided pre-calculated data.

3. Setup display controls.

According to “ImageBMP” instructions setup an image display area, the
resolution and so on, and select a thickness in slice number to display
scattering pattern.

Since a scattering data is save as complex numbers, a data type to be
displayed will be selected from “Show” list.

4. Click “Generate” to display a gray scale map.
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Numerical Data Output Using ImageBMP

“ImageBMP” displays a gray scale image of various data as a Bitmap. A
numerical value of each pixel of the gray scale map can be output for further
analysis with other application, such as Gatan’s DigitalMicrograph. A
numerical data used to generate the gray scale map can also so be output.

The file menu of ImageBMP and the image display windows have “Export
Data...” command as shown below:
Edit Window Help

Open... Ctrl+0 |

Close Window Ctrl+W

Ctrl+S

Save As.. Ctrl+Shift+S

Export Data... Ctrl+Shift+E
Load BMP... Ctrl+Shift+L
Page Setup... Ctrl+Shift+P
Print... Ctri+P
Exit

A numerical data used to generate the gray scale map can be output using
the “Export Data...” command of ImageBMP.

A numerical value of each pixel of the gray scale map can be output using
the “Export Data...” command of each image display window.

Output format for numerical data:
The following data format(s) will appear in the “Save as type” list in
the Save As dialog.

TIFF output (.tif)

Binary output (.pfm: Portable Floatmap File)
Text output (.csv: Comma Separated Values File)
Gatan format (.gfx)

Real data

Complex data | TIFF output (.tif)
Binary output(.pcm: Portable Complexmap File)
Gatan format (.gfx)

Output format for numerical data:

TIFF output (.tif)

Binary output (.pfm: Portable Floatmap File)
Text output (.csv: Comma Separated Values File)
Gatan format (.gfx)

Real data

NOTE Portable Floatmap/Complexmap File (.pfm/.pcm) format has a text
header. xHREM uses a header of 192 bytes including an image size.
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Close Multiple Bitmap Windows

Each bitmap window will be closed by choosing "Close" from "File" menu
or pressing the "Close" button of the bitmap window. When the bitmap
image has not been saved, a warning dialog confirming data save will
appear. This warning dialog will be suppressed, when the window is closed
while pressing the "Shift" key.

When you have calculated multiple bitmap images, it will be tedious to
close each image window one by one. The following shows the handy ways
to close the multiple bitmap windows.

1) File menu (or Close button) of the bitmap window

While pressing the "Alt" (Windows)/"Option" (Mac) key, you can choose
the "Close" from "File" menu or press the "Close" button of the bitmap
window. Then, all the bitmap windows will be closed one by one after
confirming data save for the image that has not been saved.

You can abort the closing process at any time by choosing the “Cancel”
button in the save dialog.

When the above closing process is activated while pressing also “Shift” key,
all the bitmap windows will be closed without showing the save dialog.

2) “Exit” (Windows)/”Quit” (Mac) (or Close button) of the ImageBMP
window

All the bitmap windows will be closed after displaying the save dialog for
each image before exiting from ImageBMP application.

You can abort the closing process at any time by choosing the “Cancel”
button in the save dialog.

When the above closing process is activated while pressing “Shift” key, all
the bitmap windows will be closed without showing the save dialog.

The same procedures will be used to close the multiple bitmap windows
generated by STEMimage.
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Application

In this chapter

we explain how to create your own data,

and the way to customize xHREM™

by using Preferences and Templates.

Then, you will see a detailed explanation for each data item
of the Graphical User Interfaces.

B | et's attack a problem in hand

Before proceed to this chapter, please get acquaintance with XHREM by
going through the examples of the "Getting Started."  In this chapter, you
will learn how to create a new data for your own problem, and then how to
display your results and more...

Steps to create a New Data

There are two ways to create a new data for your application:
e Update an existing data

o Create a data from scratch

To create a new data from an existing data, do this:
1. Launch a corresponding graphical user interface (GUI).

2. Choose “Open...” from File menu, and select an existing data you want to copy
in the file selection dialog.

The WORKSHEET will appear with data you select.
3. Save this data with a new name by choosing "Save As..." from File menu.

NOTE This step is strongly recommended not to lose the existing data by an
accidental overwrite.

4. Then, change data as you want.

5. When finished, save your modified again data by choosing "Save" from File
menu.

If you want to use another existing data, select it using Open... command.
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To create a new data from a scratch, do this:
1. Launch a corresponding graphical user interface (GUI).

2. The Default (blank) work sheet for a crystal data will be opened. If you want
make a non-Crystal data, then choose “Non-Crystal” from “New” command of
File menu.

The WORKSHEET named "Default (Crystal)" or "Default_NonCrystal
(Non-Crystal)" will appear with some default data.
Fill out your data in the WORKSHEET.

When finished, save your data with a new name by choosing "Save As..." from
File menu.

If you want to use another new data, select “Crystal” or “Non-Crystal” using
New command.

Edit Help

New » Crystal
Open... Ctrl+0 Non-Crystal
Close Ctrl+W [

The WORKSHEET named "Default (Crystal)" or "Default_NonCrystal
(Non-Crystal)" will appear with some default data.

Setting up Preferences

The Preferences hold some control data that does not depend on each
sample.

The calculation programs (Solvers) only accept the data with a definite
format and units. However, you may want to use other units in your
WORKSHEET. You can choose your preferred units for your input in
"Preferences" window.

To set up the Preferences:
1. Choose "Preferences" from "Edit" menu of MultiGUI or ImageGUI.
The following "Preferences" window will open.

TIPS: The first choice of Units or Defocus sign is used in the calculation
program. The data specified in other units will be converted by the
graphical user interface (GUI).

2. Change settings according to your preference.
"Apply" will change the WORKSHEET according to the change(s).
3. Click "Close" or “Cancel” to close the Preferences window.

When “Close” is clicked, the current settings of the Preferences will be
applied on the WORKSHEET.
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When "Cancel" is clicked, the settings after the last “Apply” will be
discarded. (These changes have no influence on the WORKSHEET.)

NOTE: You cannot restore the change(s) already applied to the

WORKSHEET by clicking “Cancel.” In order to restore the change(s)
on the WORKSHEET, reset the Preferences and press "Apply."

TIPS: We recommend you to verify your change(s) on the WORKSHEET
by clicking "Apply" before closing the Preferences window by clicking

"Close."
@@ Preferences - X
1 » Units Crystal setting )
Leneth: Fourier space: @®1I{a b, c) <+
® Angstrom  Onm ®s=sing /1 O1ib, c a)
Thickness: O d=2sin8 /4 O e, a b)
O Units @®Slices Beam convergence angle: O ib, 3, -c)
Defocus sign (underfocus): 8 Z: zsm 9;/11 OV ic b, -a)
@®plus O minus acl o
(® mrad OVi(a.c.-b)

Half-tone gray scale control

3 > (® Gamma control : Brightness: Contrast:

O Manual 08 0.7 06 05 045 Set
04 035 0.2 0.15 0.1 Undo

Dynamical calculation Numeric output format

4 » Ranee: /Bnestrom Field width: D <« 5
Slice thickness: I:] cells Blank lines: D

Atomic Scattering Factor
(O Mott Formula with Doyle-Turner ¥-ray Scattering Factor
(® Weickenmeier-Kohl Scattering Factor Including TDS Absorption

Load Default Apply Cancel

The first choice of Units or Defocus sign is used in the calculation program.
The data specified in other units will be converted by the graphical user
interface (GUI).

1.  Units
Length: Angstrom, nm
Thickness: Unit cells or slices
Defocus sign (underfocus): plus, minus
Fourier space: s, d*
Beam convergence angle: s, d*, mrad
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TIPS: Calculation programs use the unit that is the first in the selection list.
Therefore, the Graphical User Interface (GUI) converts the value specified
in other unit to the standard unit necessary for a calculation.

2. Crystal setting
I(a,b,c)

Entrance surface

a
IL... Axes are permutated as indicated
3. Half-tone output settings
Level settings for character-base half-tone output (11 levels)

4. Dynamical calculation
Range: Radius of Fourier space to be included in the calculation
Slice thickness (cell numbers): to be used for the projection approximation

5.  Numerical data output format

Field width: Number of characters including blank(s)
Blank lines: number of line feed(s)

6. Atomic Scattering Factor

When you want to include TDS absorption using Weickenmeier-Kohl scattering
factor, you have to specify a thermal factor (Debye-Waller factor) for each atom as
an atom parameter.

Doyle-Turner scattering factor can be used up to only s=2.0 (d*=4.0) due to its
approximation.

Creating Your Template WORKSHEET

Graphical user interface (GUI) uses a WORKSHEET for data preparation.
xHREM is shipped with WORKSHEETSs (Default.WS1 etc.), on which
some standard values are already specified. We call these WORKSHEETS
having standard values as "Default (Template)." When you create a new
data, you can save your trouble to input these common data at each time by
using the Default WORKSHEET.

Moreover, you can prepare the data with less effort by using the
WORKSHEET tailored for your experimental conditions. For examples,
an acceleration voltage, an output range for dynamical scattering amplitudes
etc. for the scattering calculation, or a spherical aberration coefficient, a
defocus spread, a bean convergence angle, an aperture radius etc. for the
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image intensity calculation. You can create a template WORKSHEET
with other preferential settings.

Creating a template WORKSHEET will follow the same steps as preparing
the new data. However, only default data items are specified instead of
filling out all entries.

To create a new data from a scratch, do this:

1. Launch a graphical user interface (GUI) for which you want to create a
template.

Select "Default" from the file selection dialog.
Specify default data items.

Save your WORKSHEET with a specific name, which reminds you that it is a
template data.

From next time, you can start with your template saved above and save
your trouble by using these predefined data items.
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B MultiGUI Reference

WORKSHEET (Crystal)

-
@ SnO2 (Crystal) - MultiGUI

File Edit Help

1P| Title: Sn02
Cell Parameters

2P

a 4737

p 4737

c 3.186

o 90

g 90

v 90

Angstrom
Angstrom

Angstrom

Calculation Control

5 > Phase Grating (PG) Setup

Dividing a cell into 1 v slices
Overwrite the PG, if exist

6 > Multislice Calculation

Qutput Control

@ Start from beeinning

() Continue/Resume

Up to 20

slices

[ PG Sequence

]

10 P> Potential Distribution:

1 1 » Wave Function:

Options

Export Data for Gray Scale Map

Every 10 slices

Export Data for Gray Scale Map

Symmetry Operation

136: P4(2)/mnm
Elements 8

Atom Parameters

No. of Atoms 2

Overall Thermal Factor 1

fcc Voltage 100

kW

Incident Beam Direction:

al b

Unitary test:
Limit 099

0 c 1

Every 10 slices

Dynamical Structure Factor:

Range 05
Every 1

/Bngstrom

slices

[ Optional Setup ]

| DIFFUSE

] [ GCBED

[

STEM |

Model View

4“3
<4
<7
<8
<9
<« 12
<13
<14
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WORKSHEET (Non-Crystal)

r R
@D Untitled (Non-Crystal) - MultiGUI =R
File Edit Help
1 P Title:
Cell Parameters Symmetry Operation
Model Space Select Pl
- 10 { 0o+ 10 ) Angst
2 * @ nestrom Edit Elements 1
b: 10 { no+ 10 ) Anestrom
c 1 { 00+ 1 ) Anegstrom Atom Parameters =
o 90
B 90 No. of Atoms 0
1 90 Overall Thermal Factor 0
Calculation Control
Phase Grating (PG) Setup Acc Voltage 100 KW
1. Title (max. 82 characters)

Cell

Type a sample name, composition, and experimental conditions etc. as
you want.

Parameters

Specify cell lengths and angles. The cell lengths can be given
Angstrom or nm according to your preference. The angles can be given
in degree or cosine of the angle. A mixed input of angle in degree or
cosine is not allowed. (Input in angle is recommended.)

In the case of a non-periodic/non-crystal model the size of the super-cell
that is the sum of a model size and a space (vacuum).

Symmetry Operation

You can specify symmetry operations by selection one of the space
groups by clicking "Select" or edit them by clicking "Edit."

Note: In the case of Non-Crystal the space group cannot be select. The
space group P1 is always assumed.

"Select" button:

Clicking the "Select" button will open the following window showing all
possible space groups. Select one of the space groups corresponding to
your specimen. The space group you have selected will appear in the
box.
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W Symmetry Selection Table Q@@

1 :P1 2 :P~1 3 P2 33 _: P2 4 P2(1) Lo

4a : P2(1) 5 _:B2 53 : (2 6 _:Pm 63 _: Pm

7 _:Ph 73 :Pc 3 _:Bm B3 : Cm 19 :Bb

193 : Cc 10 : P2/m 10a : P2fm 11 : P2(1)fm 11a : P2{1)im

12 :B2jm 123 : C2fm 13 :P2jb 13a: P2jc 14 :P2{1)h S -

14a: P2(1)fc 15 : B2fb 15a: C2/c 16 _: pP222 17 P222(1)

18 : P2{1)2(1)2 19 : P2(1)2{1)2(1) 20 : C222(1) 21 : C222 22 : F222

23 11222 24 :12(1)2(1)2(1) 25 : Pmm2 26 : Pmc2(1) 27 :Pcc2

28 : Pma2 29 : Pcaz2(1) 30 : Pnc2 31 : Pron2(1) 32 : Pha2

33 : Pna2(1) 34 : Prn2 35 _: Crm2 36 _: Crnc2(1) 37 : Ccc2

38 _: Amm2 39 : Abm2 40 : Ama2 41 : Ana2 42 : Frnm2

43 : Fdd2 44 : Imm2 45 : Iha2 46 _: Ima2 47 & Promm

48 _: Pnnn 483 : Prinn 49 : Pcom S0_: Phan 503 : Pban

S1 : Prma 52 _: Prna 53 _: Prna 54 : Pcca 55 _: Pham

56 _: Pccn 57 _: Phcm 53 : Pnnm 59 _: Pmmn 59a : Prmn

60 _: Pbcn 61 : Phca 62 : Pnma 63 : Crncm 64 : Crnca

65 _: Cromm 66 : Cccm 67 : Cmma 68 : Ccca 683 : Ccca

69 : Fromm 70 : Fddd 70a : Fddd 71 : Irrnm 72 _: Tham b
[ View ] [136:P4@/mnm | [ ok | [ Cancel |

You can see symmetry elements in the window (see "Edit" button below)
appeared by clicking the "View" button. Please confirm the symmetry
elements are correct before proceeding the calculation.

"Elements": Number of symmetry elements
"Edit" button:

Clicking the "Edit" button opens a window where you can specify
arbitrary symmetry operations.

ml Symmetry Editor

| x vz =% -y, 2 124, 1727y, 1/242,1/2-%,1/2+y, 1/242;
¥, X, 2 =Y, X 2 1724y, 1/2-%, 17242, 1/2-y, 1/2+4x, 1/2+2.

[]Center of Symmetry ( OK | | Cancel |
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Symmetry operations should be specified according to the conventions
used in International Tables for Crystallography.

® xyz components of each symmetry operation should be separated by a
comma (,)

® Each symmetry element should be separated by a semicolon (;)

® Symmetry list should end with a period (.)

4. Atom Parameters
Atom parameters will be imported from a data file by choosing "Import"
or compiled in the window that will appear by choosing "Edit."
"Import" button:

Clicking the "Import" button will open the window to select an existing
atom parameter file.

r B
@ Atom Parameter Importer | = | | ]
Separator
DataiBase @ Spacefls) Comma
OHI:

Atom Coordinates (XY.Z) Unit:

Parameter Sequence:

No v | [Name v [x¥z v|[Occupsney v || Therml )

| Select | | Cancel |

® Data Base: atom parameters already saved by MultiGUI.

® Text Data: atom parameters saved in the text format.
Data Separator: space(s) or comma can be used as a data separator
Parameter Sequence: the order of data items will be specified. If there is
no corresponding data item in the file, you may use "None" to skip
reading it.

Data file will be selected in the dialog that appears by clicking the
"Select" button.

Input unit of atom coordinates: Unit of the atom coordinates can be
selected using Atom Coordinates Unit pull-down.

When the atom parameters are imported successfully, these parameters
will be displayed in the window (see "Edit" button below).
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"Edit" button:

Clicking the "Edit" button opens a window where you can compile atom
parameters on the spot.

r B
@ Atom Parameter Editor [ = E I—Zhl
File Edit
( Cancel ] Export j Fraction
No Name X Y z QOccupancy Thermal -
1 Sn 0 0 0 1.
% 0] 0307 0307 0 1. 0
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20 v
21
A
® No: sequence number added automatically
® Name: atom name including element name. Ex. Ag, C(1), O-2
® X, y, z: atom position in the unit cell defined by a fraction
® Occupancy: ratio of occurrence of atom (normally, one). This

parameter may be omitted.

® Thermal: isotropic thermal displacement factor. If you input zero (or
leave blank), then the Overall Thermal Factor (see the next parameter)
will be applied in the calculation.

Export: Atom coordinate data is exported as a text format data (fixed data
length), whose extension is. atm.

Atom coordinate unit: When creating a non-crystal manually, an atom
coordinate unit is selected from Angstrom/nm.

No of Atoms: number of input atoms
Overall Thermal Factor:

Isotropic thermal displacement factor that will be applied for each atom
in the crystal. If the thermal displacement factor of each atom is specified
as zero or left blank, this thermal displacement will be used for that atom
in the calculation.
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Calculation Control

5. Phase Grating Setup

Dividing-a-cell-into box: Select a number of divisions of unit cell (up to
thousand (1000)). The phase grating number up to 10 can be selected
from the pull-down list. If you want to use more than 10 phase gratings,
simply input a number (up to 1000) of phase gratings t.

O On/off Overwrite the PG, if exist

The phase gratings (PGs) will be calculated automatically, if necessary.
This check box controls whether a new PGs are calculated, or the
existing PGs are used, when the PG file of the same name is exist.

6. Multislice Calculation
O On/off multislice calculation

Up to box: set the last sample thickness in unit cell of slice number (up to
9,999 slices)

Start from beginning & Continue/Resume buttons: select "Start from beginning"
when you start a new calculation, or "Continue/Resume" when you
continue calculation by increasing the last sample thickness. In the case
of STEM calculation, if you stopped the calculation in the middle, you
can resume calculation from the next scan point using
"Continue/Resume".

NOTE: In the case of STEM calculation you cannot continue calculation
by increasing the last sample thickness.

PG Sequence buttons: A default phase grating sequence is a cyclic
repetition of O to the number of phase grating. You can edit the sequence
using the Sequence Editor that appears by clocking the “PG Sequence”

button.

r | l‘
@@ Phase Grating Sequence = | J
Jr2o120120
tzotr2o01201
2012012012

1/30 [ oK ] [ OCancel |
Note: You can copy/paste within this window or paste copied text from another application.
A

The sequence is specified by the space-separated phase grating numbers.
7. Acc. Voltage
8. Incident Beam Direction

Specify an incident beam direction in term of a real lattice coordinates.
Ex: [001] incidence.
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9. Unitary Test: A test for the sum of scattering intensity
Limit: A number close to one imposes a strict condition.
Cycle: Frequency for the test in the sample thickness unit

Output Control

10. Potential Distribution
O On/off file output for gray scale display

11. Wave Function
O On/off file output for gray scale display

Cycle: Frequency for the file output in the sample thickness
12. Dynamical Structure Factor

Range: File output range (radius) of scattering amplitudes

Cycle: Frequency for the file output in the sample thickness

13. Optional Setup

F I Al
@ Optional Setup (a=| J

Half-tone{Character) Map:

(V] Potential Distribution
Vertical 0 <=5 1

Horizontal 0 <> 1
Scale 1 Anestrom/inch
Numerical Map:

(] Potential Distribution

™| Wave Function Step

Vertical 0 <> 1 D
b~

( OK | [ Cancel ]

Horizontal 0 > 1

A

Half-tine Map
0 On/off Potential distribution

Vertical and horizontal ranges and scale for half-tone output
Numerical Map

[0 On/off Potential distribution
O On/off Wave-function

Vertical and horizontal ranges and steps for numerical map output

Options

14. Additional function setup dialogs and xModelView
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CBED and STEM are extensions to xHREM, and require additional
licenses.

ImageGUI Reference

WORKSHEET

-
@ Untitled - ImageGUI

File Edit Help

2>

Dynamical Scattering Data: Unspecified
3 » Title: your comment here

Optical Parameters

Spherical aberration coefficient (C3) 05 mm

Fifth order Spherical aberration (C5) 0 mm

Defocus spread 50 Angstrom

Beam convergence 003 /Bngstrom

Aperture  radius  inner 0.0 outer 05 /Bnestrom
position a¥ 0.0 b* 0.0

Zernike Phase Plate 00 pai

4 : Simulation Mode: @) First order{Envelope) () Second order(TCGC)

Specimen thicknesses (slice number):

6 —p» Defocus values (Anestrom)

Qutput control

7 Export Data for Gray Scale Map Optional Setup ]
8 ["] Structure Factor

{Kinematical scale)

1. Dynamical Scattering Data
Select the scattering data that is calculated with MultiGUI using the Browse button.

2. Title (max. 82 characters)

Type a sample name, composition, and experimental conditions etc. as
you want.

3. Optical Parameters
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® Spherical aberration coefficient (C3)

® Fifth order Spherical aberration (C5)

® Defocus spread

® Beam convergence

® Aperture radius: inner and outer positions
® Zernike Phase Plate

Specified phase shift will be applied in the area inside of the inner
aperture. If the phase shift is zero, the beam within the inner aperture is
blocked.

4. Simulation Mode

Partial coherency will be treated by First order (Envelope) approximation
or Second order (TCC) approximation.

5. Slice thicknesses

Specimen thickness at which EM images will be calculated will be given
in terms of slice number (up to 10 slices).

6. Defocus values

Defocus values at which EM images will be calculated will be specified
(up to 20 values). Sign and unit of defocus will be changed by
Preferences settings.

Output Control

7. Export Data for Gray Scale Maps (Microscope Images)

If you select this option, binary data will be exported to the file for later fray
scale display using Image BMP.

8. Structure Factor

If you select this option, structure factors will be listed before image
calculations for each lice data.

9. Optional Setup
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-
@D Opticnal Setup

=)

Half-tone{Character) Map:

Microscope Images
Vertical 00 <> 10
Horizontal 00  <-> 10

Scale 1 Angstrom/inch

[ Reversed Contrast
Normalized

Numerical Map:

["] Microscope Images Step

Vertical 00 <> 10 [E
b -

Horizontal 00  <=> 10

( 0K ] [ Cancel

)

n

Half-tone Map
1  On/off Microscope Images

Vertical and horizontal ranges and scale for half-tone output

O On/off Contrast Reversal
O On/Off Normalization

Numerical Map
LI On/off Microscope Images

Vertical and horizontal ranges and steps for numerical map output
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m DFOutGUI Reference

WORKSHEET

4 R
@ Untitled - DFOUtGUI L] o et

File Edit Help

1 I Dynamical Scattering Data: Unspecified

Qutput Control
Ranee: @ all Size  Height: 300 pixel

Step: 1 slices e

Ihdices of Reflections:

<> Width: 450 pixel

Page No 0 1 2 3 4 5

H K H K H K H K H K H K

Index1

Index 2

Index 3

Index 4

Index 5

Index 6

Index7

Index 8

Index 9

UL }

2.

3.

Dynamical Scattering Data
Select the scattering data that is calculated with MultiGUI using the Browse button.

Output Control

Output Range: Thickness for a list and/or graph output will be specified
by its range and step in slice unit.

Size: Specify the size of graphical output window.
Draw: Draw graphical output.

Resize: All graphical output will be redrawn with the specified window
size.

Indices of Reflections

Indexes of reflections you want to check will be specified in a column
(up to 9 reflections). Reflections in each column will be displayed
graphically in the same page (up to 10 pages).

Reflection indexes should be specified by a two-dimensional index in a
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(projected) diffraction pattern.
Output Diffraction Intensity

Choose “Numerical Output” in File menu to view diffraction intensity
(amplitude and phase) in numerical value.

Edit Help

New

Open.. Ctrl+0
Close Ctrl+w
Save Ctrl+S
Save As... Ctrl+Shift+S

Numerical Output
Export Data

Exit

Then, the dialog “Numerical Output” for output control will appear.

rlml Numerical Qutput l =1 M

() Kinematical scale

[ Ihclude Kinematical SF.

| OK | [ Cancel |

The amplitude is displayed as a normalized value relative to an incident
wave (Normalized), or as a scaled value relative to kinematical scattering
amplitude (Kinematical scale).

If the checkbox “Include Kinematical S.F.” is selected, the kinematical
structure factor will be included at the top of the numerical output.

Clicking “OK” button, the separate windows will be open, where
amplitudes and phases of the specified reflections are displayed
numerically. When an execution terminates normally, you will see the
message "Execution completed. Congratulations!"
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A

-
@ SnO2test DFOut

Eile Edit Help

1 DYNAMICAL STRUCTURE FACTORS BASED ON MULTISLICE METHOD

HHRHRSNO02

Do oW -

o w @~ @

12
123
14
15

16
17
18
19
20

oo o oo oo o oo oo o oo

oo ooo

WAYE LENGTH=0.03701

MAX I HDEX=

OUT-PUT SLICES ARE FROM
NORMALIZED AMPLITUDE AND PHASE OUTPUT

99536
98189
96086
93429

87557
84965
82992
81833
81558

82089
83222

87312

87964 -1,
-1.
-0.
-0.
-0.

87915
87082
85377
82907

-1.
-1
-1.
-1.
0484 -1.

-1.
-1.
-1.
-1.
-1.

-1.
-1,
84674 -1.
86134 -1,
-1.

51
48
a1
38
33

30
23
28
28
27

28
25
22
18
13

08
01
95
88
81

eepepeR

seepeperR

00000
00000
00000
00000
00000

00000
00000
00000
00000
00000

00000
00000
00000
00000
00000

00000
00000
00000
00000
00000

oo o oo oo o oo oo o oo

oo ooo

00
0o
00
0o
00

00
00
00
00
00

00
00
00
00
00

0o
00
0o
00
00

oo o oo

oo o oo

1€

1 TO 9999

01307
02634
03998
05412
06281

08393
09320
11414
12815
14053

15057
15757
16100
16047
15589

14757
13635
12388
11282
10737

-2.
-2.
-2.
-2.
-2.

-~ ~ oo o

[ N T,

33
B2
90
18
a3

71
95
18
40
61

80

.98
-3.
-2.
-2.

13
99
88

76
69
68
73
85

16
BY 1

0.00000
0.00000
0.00000
0.00000
0.00000

00000
00000
00000
00000
00000

oo o oo

00000
00000
00000
00000
oooo00

oo o oo

0.00000
0. 00000
0.00000
0.00000
0.00000

ocoeee ooeee ooeoee

eseopee

SCALE

00
oo
00
oo
oo

o0
00
oo
00
oo

oo
00
oo
00
oo

oo
00
oo
00
oo

TO ABSOLUTE

oo o oo

oo o oo

00982
01341
02845
03656
04343

04878
05245
05444
05481
05371

05130
04773
04313
03758
03115

02330
01587
o072z
00302

-2.
-2.
-1
0
01224 1.

id:2:2:3

B.0623e+2

34
55
76
97
17

38

.59

81

.03

28

43

.73
.97
.07
-2.

83

58
31
94
50
21

m

TIPS: The kinematical structure factors (scattering amplitudes) used in
potential calculation will be displayed, when you check the “Include
Kinematical S.F.” check box, or set a starting slice to zero in “Output
Range” section.

NOTE: The progress window has the fundamental menus such as File

and Edit, and you can Save the content of the window from the File
menu.

TIPS: The program can be terminated even in the middle of calculation
by Exit command from the File menu or clicking the close button.
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B ImageBMP Reference

WORKSHEET

For EM Image Intensity Data

1»

2>

3%

The title of the data and its projected two-dimensional cells (and the number
of sampling points) will be shown at the top part of the window.

For Data from Dynamical Calculation

Image Selection

(%) Potential: U

() Wave Function:
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g A
@ Sn02.AUX - xImageBMP Lo o [t
File Edit Window Help
Title: Sn02|
Unit Cell
a 4.737 Angstrom b: 4737 Anestrom angle: 90.0
{ 32 points ) { 32 points ) { cosine 0.000)
Digplay Ranee
a0 ¢ N b0 > 1
Imaege Size Display Limit
Height: 58 pixels Low: Minimum
Width: 58 pixels High: Maximum
12 pixels/Anestrom Survey * 4
Image Selection | Reverse Contrast 5
Slice: [IU '] 6
] Atom Overlay
Defocus: [500 v]
- <7
Image Tableau Tableau Setup Generate
L\ A



For EM Image Intensity Data

1. Display Range
The range of display will be defined in terms of unit cell.
2. Scale (pixel/Angstrom)

The scale will be specified by a number of pixels per Angstrom. Total
numbers of pixels (Height and Width) to be displayed will be shown
estimated according to the scale.
3. Image Selection
® Slice

The specimen thickness (slice number) for an EM image to be displayed
will be selected from the slice list. When you select "All", images for
all slices in the list will be generated one by one. When you choose
“Select”, a dialog where you can select individual image will appear.

® Defocus

The defocus value for an EM image to be displayed will be selected from
the defocus list. When you select "All", images for all defocus values in
the list will be generated one by one. 'When you choose “Select”, a
dialog where you can select individual image will appear.

NOTE: In this utility an under-focus value is always positive irrespective of
your defocus sign selection in the "Preferences."

® Image Tableau (Table Layout)

This will control the way of display of selected images. When checked,
the selected images will be displayed in a table layout. Otherwise, each
selected images will de displayed separately. When you click “Tableau
Setup” button, a dialog to setup a layout will be opened.

Layout (Horzontal Avertical)

(®) Defocus/Thickness

O Thickness/Defocus

Separaticalpixels)

Horizontal: |0

Vertical: |0

[oK ][ Cancel |

4. Survey

Clicking "Survey" will open a small window showing a display range
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(Maximum and minimum values).

Low: ﬁ!‘l_inimum ’ [ Set to Min: 3917 ]

High: éMaximum ’ | Set to Max: 997.0 |

[ 0K i [ Cancel ]

You can change the display ranges by setting numbers in the boxes.
5. Reverse Contrast

When checked, the image will be displayed with a reversed contrast.
6. Atom Overlay

When checked, a colored circle will be drawn on each atom position.
The size and color of circle for each element will be changed in the
dialog that will appear when you click “Setup” button.

Wil Size & Color
Element |Sn 0

( OK | | Cancel |

7. Generate

Gray scale image will be generated by clicking "Generate."
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For Data from Dynamical Scattering Calculation

In the selection you can choose either "Potential" of "Wave Function" to be
displayed as a gray scale image.

® Potential

The phase grating number (slice number) for which a potential
distribution is displayed will be selected from the phase grating list.
When you select "All", the potential distributions for all phase gratings in
the list will be generated one by one. When you select "Projection”, an
image obtained by summing the potentials over all slices will be
displayed.

® Wave Function

The specimen thickness (slice number) at which a wave function is
displayed will be selected from the slice list. When you select "All",
images of all wave functions in the list will be generated one by one.

® Display Type

As the potential and wave-function are saved in complex number, you
have to choose a quantity to be displayed as a gray scale image from a
following list:

Disply Type: | Amplitude v
Amplitude
Intensity L
[l A
Real
Imaginary
ImageBMP Menu
HIEN Edit  Window Help I Window Help
Open.. Ctr+O Cut Ctri+X
Load BMP..
Paste Ctr+V
Clear
Page Setup.. Ctrl+Shift+P
Exit Mouse Posgition 4
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m SpotBMP Reference

WORKSHEET

Wi Sn0O2.DF - SpotBMP

File Edit Window Help
Title: [5n02 ‘
Uit Cell
a 02111041 1/8nestrom b: 02111041 1/8nestrom angle: 90.0
{ 32 points ) { 32 points } { cosine 397582e-7 )
Cisplay Range
1 » Radius: |1 '1/Bnestrom Resolution: 128 | points/(1 /Anestrom)
{uptol) {(Imaee Size : 256 pixel)
DCisplay Setup Cisplay Limit
2> Spot Shape: (9 O Peak Low: Minimum
Spot Radius: {'17077 ' points High: Maximum
[ Show Index Slice :
Image Selection [ Reverse Contrast
4 > Siice: [ vl
Type : ‘ Log of Intensity \7'7‘ Generate

<—3

95

4—6

The title of the data and its projected two-dimensional cells (and the number
of sampling points) will be shown at the top part of the window.

1. Display Range
® Radius

The diffraction area to be displayed will be specified by its radius (in

1/Angstrom) from the center. The displayable area that is outputted by

the dynamical calculation program is indicated below the box.

® Resolution

The resolution will be specified by a number of pixels per 1/Angstrom.
An image size to be displayed will be shown estimated according to the

resolution.

2. Display setup
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Intensity
Amplitude

Display data type will be selected from the following list:
®  Show Index

On/off the reflection index display on the gray scale image
® Spot shape

You can choose a display shape of reflection spots from either "Dusk" or
"Peak."

® Spot radius
Size of each diffraction spot in pixels.
® Background Color

"White" background displays an image like a negative, and "Black"
background emulates an output on a printing paper.

3. Survey

Clicking "Survey" will open a small window showing a display range
(Maximum and minimum values).

W Untitled
Low: Minimum ; ( Set to Min: 10. |
High: Maximum | | Set to Max: 03749 |
[ 0K | [ Cancel |

You can change the display ranges by setting numbers in the boxes.
4. Slice

The specimen thickness (slice number) at which a diffraction pattern is
displayed will be selected from the slice list. When you select "All",
images of all diffraction patterns in the list will be generated one by one.

5. Reverse Contrast

When checked, the image will be displayed with a reversed contrast.

6. Generate

Gray scale image will be generated by clicking "Generate."
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SpotBMP Menu

ZEN Edit  Window Hel) |08 Window Help
Open... Ctrl+O Cut Ctrl+X
Load EMP... Cop Gtrl
Close Paste Ctrl+V

Delete
Print setup...
Exit
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m Blank WORKSHEET Appendix

MultiGUI

r A
@D Untitled (Crystal) - MultiGUI = (= &8 =|
File Edit Help

Title: |
Cell Parameters Symmetry Operation
al Angstrom 1P
b 0 Angstrom Elements 1
c 0 Angstrom
a0 Atom Parameters
o
5 W
, a0 Mo. of Atoms 0
Overall Thermal Factor 0

Calculation Gontrol

Phase Grating (PG) Setup Acc Voltage 100 Y
Dividing a cell into 1 v slices
[V] Overwrite the PG, if exist

Multislice Calculation

Ihcident Beam Direction:
a0 b 0 c 1

. it test:
Up to 20 slices kg its

Limit 099 Every 10 slices
| PG Sequence |

@ Start from beginning

() Continue/Resume

Qutput Control

Potential Distribution: Dynamical Structure Factor:
["]Export Data for Gray Scale Map Range 05  /Anestrom

Wave Function: Every 10 slices Every 1 slices
[]Export Data for Gray Scale Map [ Optional Setup ]

Options
| DIFFUSE | | CBED | | STEM | | Model View |
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Optional Setup

MNumerical Map:

[7] Potential Distribution
[ ]Wave Function Step

Vertical 0 <> 1 E]
b -]

Horizontal 0 <> 1

r@l Optional Setup l = I I—"A’—J
Half-tone{Character) Map:
Potential Distribution
Vertical 0 > 1
Horizontal 0 <> 1
Scale 1 fngstrom/inch

( OK | [ Cancel
-
@ Untitled (Non-Crystal) - MultiGUI ==
File Edit Help
-
Title: B
Cell Parameters Symmetry Operation
Madel Space
a 10 { 0o+ 10 ) Anestrom Non-Crystal
b: 10 { on+ 10 ) Bnestrom
o |1 { 0o+ 1 ) Anestrom Atom Parameters =
@
B 40 No. of Atoms 0
7 90 Overall Thermal Factor 0
Calculation Control
Phase Grating (PG) Setup Acc Voltage 100 Y,
. . 1 .
Dividing a cell into v slices Ihcident Beam Direction:
[V] Overwrite the PG, if exist T L
all b |0 c |l
Multislice Calculation . ’
— Upto 1 Unitary test: ' .
@ Start from beginning Limit 099 Every e
. [ PG Sequence - ‘
() Continue/Resume
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ImageGUI

-
@ Untitled - ImageGUI

File Edit Help

Dynamical Scattering Data: Unspecified
Title: vour comment here

Optical Parameters

Spherical aberration coefficient (G3)

Fifth order Spherical aberration {(G5)

Defocus spread

Beam convergence

Aperture radius inner 0.0 outer
position &% 0.0 b
Zernike Phase Plate 0.0 pai

Simulation Mode: @) First order{Envelope)

Specimen thicknesses (slice number):

Defocus values {Angstrom)

Qutput control

05 mm
0 mm
50 Angstrom

003 /fBnestrom

05 /fBnestrom
0.0

() Second order{TCC)

i  Browse

Export Data for Gray Scale Map
[ Structure Factor

{Kinematical scale)

[

Optional Setup

]
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Optional Setup

r@ Opticnal Setup =]

-

Half-tone(Character) Map:

Microscope Images
Vertical 00 <> 10

Horizontal 00  <-> 10

[7] Reversed Contrast
Normalized

Numerical Map:
[ Microscope Images

Vertical 00  <=> 10

Horizontal 00  <-> 10

Scale 1 Anestrom/inch

Lok JI

]
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DFOutGUI

@ Untitled - DFOutGUI

(@)

Step: 1

File Edit Help

Qutput Control

Ranee: @ all

Dynamical Scattering Data:

&

slices

Ihdices of Reflections:

Unspecified

Size  Height: 300

Width: 450

Draw

Browse

pixel
pixel

Resize

|Page No

0

=)

H

K

Index1

Index2
Index3

Index 4

Index 5

Index 6

Index 7

Index 8

Index 9

|

I
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FAQ

Frequently Asked Questions

This chapter will answer to
Frequently Asked Questions
with Q&A style

Dynamical Scattering Calculation (MultiGUI)
QO001: How to use Atom Parameter Editor?

QO002: How to use "Occupancy”?

QO003: | saw the example, where an angle of lattice parameter is zero (0)...
QO004: How many phase gratings can we use?

QO005: How many slices can we divide a unit cell (or a super-cell) into?
QO006: How is a phase grating (transmission function) evaluated?

QO007: How to specify the range of scattered waves to be included in the multislice
calculation?

QO008: What is a slice thickness for [011] or [111] incidence?

QO009: How to specify an incident beam direction?

QO010: Why is the incident beam direction with c=0 not allowed?

QO011: How to treat an incident beam direction with c=07?

QO012: How is an atom scattering factor for electrons calculated?

QO013: Can we use scatter factor for ions?

QO014: How to specify a thermal factor (thermal vibration effect)?

QO015: How does thermal factor affect an atomic scattering factor?
Q016: How do we use “Unitary test”?

QO017: What kind of propagation function is used in calculation?

QO018: What is three-dimensional effect?

QO019: How to include three-dimensional effect in multislice calculation?
Q020: How to specify model symmetry (symmetry operations)?

QO021: | can’t read atom parameters from a text file.

QO022: How to create an atom parameter file (text data)?

QO023: What is a format of atom parameter file (test data)?

QO024: How does an atomic potential contribute to a projected potential?
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Image Calculation (ImageGUI)
Q101: My image does not show any contrast.
Q102: Let me know the differences between Simulation Modes.

Q103: When | select “First Order (Envelope)” from Simulation Mode, | can get a correct
image, but not with “Second order (TCC)”.

Dynamical Scattering Amplitude Output (DFOutGUI)

Q201: Why is a reflection specified using only two indexes? How can we relate these
indexes to a normal three-index system?

Q202: How is the phase displayed?

CBED Extension

Q301: High angle area is not displayed.

Q302: Does HOLZ lines appear under the projection approximation?
Q303: Can we calculate a Large-angle CBED (LACBED, Tanaka pattern)?
Q304: How can we improve HOLZ line accuracy?

STEM Extension
Q401: An output from STEM image does not seem to represent a model structure
Q402: How to select a super-cell size?

Q403: Computation becomes extremely slow, when a model size becomes large.

Q404: What is a range to be included for scattering calculation? Does this range depend
on the model size?

Q405: What is a strategy to shorten computation time?
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Dynamical Scattering Calculation (MultiGUI)

QO How to use Atom Parameter Editor?

1. Click “Edit” button from Atom Parameters pane. Then, the following “Atom
A Parameter Editor” window will appear. In this example, the parameters for two
atoms are already registered.

r A
@ Atom Parameter Editor |ﬂiﬂ_hj
File Edit
[ Cancel ] £ Export 1 Fraction
No Name X Y Occupancy Thermal -
1 Sn 0 0 0 1.
g 0 0307 0.307 0 1. 0
4
5
6
7
3
9
10
11
12
13
14
15
16
17
18
19
20 »
21
A

2. Input the following parameters for each atom in separate row.
e “Name”: Atom identifier including an element name. You can add
figure(s) before or after the element name to identify each atom.
e “x”,“y”and “z”: Atom positions in terms of a unit cell length.
“Occupancy”: Average probability of occupying the site (normally one).
e “Thermal”: Thermal parameter, namely Debye-Waller factor. If this

parameter is zero (0), “Overall Thermal Factor” will be used.

3. When you finish entering the parameters for all the atoms, click “OK” to save
the data and close the window. You can click “Cancel” to abort an input at any
time.

NOTE You can save atom parameters as a text file by clicking “Export.” Then,
you can edit its content easily using your favorite text editor. You can import atom
parameters in a text file using “Import” in the “Atom Parameters” pane of MultiGUI.
Please check also Q023.

How to use "Occupancy”?

Qoo02
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“Occupancy” is a probability, with which the element occupy the site as an average

A over many unit cells. Since each element cannot occupy the site in fraction,
occupancy is normally one (1). However, in a disordered structure, for example, a
specific site will be occupied more than one element, and an occupancy of each
element becomes less than one,

For a special atom position, the symmetry operation generates an atom at the
original atom position. “Multiplicity” (the total number of symmetry-generated
atoms at the same position) is automatically taken into account by xHREM, so you
may not necessary to set “Occupancy” to 1/“Multiplicity” as sometime required by
other software.

| saw the example, where an angle of lattice parameter is zero (0)...

Qoo3

A You can specify an angle in terms of cosine. Thus, zero means 90 degree. However,
you should not mix a degree and cosine, so a mixed set of three angles, say 0, 0, 120
are not acceptable.

TIPS Cosine of the angle is used inside the program.

How many phase gratings can we use?

Qoo04

You can use up to 1000 different phase gratings. The sequence of the phase grating
A to be used in calculation will be easily is specified by using “PG Sequence Editor”.

How many slices can we divide a unit cell (or a super-cell) into?

Qoo5

Since the maximum different phase grating is 1000, you can divide the unit cell
A (your model structure) into 1000 slices.

How is a phase grating (transmission function) evaluated?

Qoo6

A A phase grating is directly evaluated by assigning a projected potential of the slice
to a complex exponential function. Here, the direction of potential projection is not
perpendicular to the slice, but along the incident beam direction.

How to specify the range of scattered waves to be included in the multislice

QOO? calculation?

The range of scattered waves included in the multislice iteration is specified by
A “Range” parameter of “Dynamical Calculation” pane of the Preferences window.
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What is a slice thickness for [011] or [111] incidence?

Qoos

Normally, the slice thickness is measured perpendicular to the slice (this is a
A physical thickness of the slice). However, the length of a slice measured along the
incident beam direction is more important from electron scattering point of view.

For example, the scattering conditions are different even for the same incident beam
direction of [011], when the incident surfaces is (001) or (011). xHREM can handle
such differences.

xHREM uses the slice that is always parallel to the entrance surface, but projects
the potential along the incident beam direction.

If you are interested in knowing more details, please consult the paper:
K. Ishizuka, Acta Cryst. A38 (1982) 773-779.

How to specify an incident beam direction?

Qoo9

An incident beam direction # is specified by three unit cell vectors in the real space
A as follows: ¢t =da+d,b+d;c

For example, the incident beam direction parallel to c-axis is defined as [0, 0, 1]. If
the incident beam direction is not specified by a simple sum of three unit cell
vectors, it is not a good condition to take an EM image.

NOTE In an experiment of electron diffraction, the incident beam direction may be
specified by the Laue point, which corresponds to the Ewald sphere center projected
on the observation diffraction plane.
TIPS Given the incident beam directions specified in real and reciprocal unit cell
t=da+d,b+dsc
= rla* + rzb* + 15

*

each coefficient can be easily evaluated as follows:
d=ta" =ra’+nrnba +rca

n=ta=da’ +d,ba+d.ca
QO‘I O Why is the incident beam direction with c=0 not allowed?

xHREM assumes that an incident surface is the (001) plane (the c-plane of an input
A unit cell). Thus, the incident beam direction with c=0 means that the electron beam
is parallel to an entrance surface, which is not occurred in practice.

TIPS You can specify an incident surface of the specimen, on which an electron
beam impinges. Therefore, using xHREM it may become possible to treat a surface
effect that is usually neglected by other programs.
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QO‘I 1 How to treat an incident beam direction with c=07?

An incident beam direction with ¢=0 in terms of an input unit cell is not accepted

A (see QO010). To handle this problem, you can transform the coordinate system from
“Preferences” dialog under Edit menu, and make the entrance surface include the c-
axis.

MultiGUI takes care of all the necessary transformations, such as atomic
coordinates, symmetry operations, an incident beam direction and so on, and creates
a correct data set for calculation.

QO‘I 2 How is an atom scattering factor for electrons calculated?

Atom scattering factor (ASF) can be chosen from the following two types in the
A “Atom Scattering Factor” pane of “Preferences”.

Doyle-Turner: ASF for electrons is calculated from x-ray ASF using the following
Mott’s formula:

f.(s)=0.023934{Z - f (s)}/s*; s=sin6fA

Here, x-ray ASF is approximated by a sum of Gaussians, whose coefficients are
tabulated in International Tables for x-ray Crystallography, Vol. IV. It should be
noted that Doyle-Turner ASF is valid only up to s=2.0.

Weikenmeier-Kohl: This form factor is valid also for high-angle scattering beyond
s=2.0. Thus, this form factor can be used to estimate absorption potential due to
thermal diffuse scattering (TDS).

QO‘I 3 Can we use scatter factor for ions?

In principle, the answer is YES. However, the current GUI does not support such
A cases, and you have to modify manually the data (.DA1) created by MultuGUI.
Please contact our user support for detailed steps.

QO‘I 4 How to specify a thermal factor (thermal vibration effect)?

A Effect of thermal vibration is taken into account by using a Debye-Waller thermal
factor.

® When you want to use a different thermal factor to each atom, you can specify
each thermal factor at “Thermal” column of atom parameters.

® When “Thermal” parameter of individual atom is zero, the thermal factor
specified at “Overall Thermal Factor” will be applied to that atom,

TIPS For simplicity, you may want to use the same thermal factor for all the atoms
in the model. In this case, specify the thermal factor in “Overall Thermal Factor” and
leave blank (or set to zero) at “Thermal” column of each atom.
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QO‘I 5 How does thermal factor affect an atomic scattering factor?

A An atomic scattering factor (ASF) is attenuated by a Debye-Waller thermal factor
B as a function of a scattering angle 0:

. B ( sin@)2
X —
P77 2

You may note that high-angle scattering is more affected by thermal vibration than
low-angle scattering.

How do we use “Unitary test”?
Qo1e

Without absorption there is no decrease of electrons. Thus, the total sum of electron

A density distribution or electron diffraction distribution is always constant. However,
if an enough scattering area is not included in scattering calculation, some electrons
tends to scatter outside of the scattering area, and the total sum of diffracted
electrons will decrease with a sample thickness. Therefore, Australian group
introduced the Unitary Test to check calculation conditions for their reciprocal-
space multislice formula.

However, xHREM uses the multislice formula (in mixed-space) based on Fast
Fourier Transform (FFT), and thus the total sums of both electron density
distribution and electron diffraction distribution are identical, and always equal to
unity. Therefore, a usual way of Unitary Test has no meaning.

The Unitary Test of xHREM calculates the total sum of electron diffraction
distribution excluding intensities at the outermost pixels. Therefore, if an enough
scattering area is not included in scattering calculation, the total sum of scattering
distribution will decrease with a sample thickness. However, since this attenuation
is mild, the Limit of Unitary Test should be very close to one to make the test
effective.

NOTE When you include absorption due to thermal diffuse scattering (TDS) using
Weikenmeier-Kohl atomic scattering factors, a number of electrons will actually
decrease due to absorption. Thus, if you don’t set the Unitary Test limit sufficiently
low, a computation will stop in the middle of multislice iteration (scattering
calculation) owing to the Unitary Test.

QO‘I 7 What kind of propagation function is used in calculation?

xHREM uses the propagation function that corresponds to a spherical wave, not a

A propagation function with parabola approximation. If you are interested in knowing
more details, please consult the paper: K. Ishizuka, Acta Cryst. A38 (1982) 773-
779.
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QO‘I 8 What is three-dimensional effect?

Three-dimensional effect is such that relative atom positions along the incident
A direction of an electron beam affect scattering intensity distribution,

QO‘I 9 How to include three-dimensional effect in multislice calculation?

Three-dimensional effect may be included in multislice calculation, when relative
A atom positions along the incident direction of an electron beam are taken into
account by dividing a unit cell (model structure) into a multiple slices.

NOTE How accurate the multislice formulation can take into account a three-
dimensional effect is still an open question.

QOZO How to specify model symmetry (symmetry operations)?

The way to specify symmetry operations follows the rule used in International
A Tables for Crystallography.

® yxz components of symmetry operation will be separated by a comma (,).
® cach symmetry operation will be separated by a semicolon (;).
® cnd of all the symmetry operation is a period (.).

Example:
X, Y, Z; Y, X, z+1/2.

Q02‘| | can’t read atom parameters from a text file.

A Please make sure that you are specifying parameter entries in a correct order.

How to create an atom parameter file (text data)?

Qo22

Input a name, coordinates (X, y, z), occupancy and thermal factor for each atom in

A a single line using an editor or a word processor. A serial number can be added
at the beginning of each line. Each parameter will be separated by a comma (,) or
any number of spaces (blanks). Thus, you don’t need to align the column position
of each parameter.

Example
Name X Y X Occupancy Thermal
Sn1 0 0 0 1.0 0
O1 0.307 0.307 0 1.0 0

NOTE Name should include an element name. You can add a number to the
element name to distinguish different atoms of the same element.

Save a created data to a text file (sample-name.atm).
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What is a format of atom parameter file (test data)?

Qo023

Atom parameter file is a text file, each line of which contains a name, coordinates
A (X, y, z), occupancy and thermal factor. A number can be added at the beginning of

each line. Each parameter will be separated by a comma (,) or any number of spaces

(blanks). Thus, you don’t need to align the column position of each parameter.

The order of parameters in the text file may be arbitrary, since the order of
parameters can be specified as shown below, when you read them.

r N
@@ Atom Parameter Importer ‘ = [ ]

Separator

i @ Spacels) ) Comma

Atom Coordinates (XY.Z) Unit:

Parameter Sequence:

Mo v | [Mame v |[x¥z v |[Occupsney v | [ Thermal v/

[ Select | | Gancel |

A

Unit of the atom coordinates can be selected using Atom Coordinates Unit pull-
down. This function is especially useful, when you create a atomic model using a
third-party model building application.

How does an atomic potential contribute to a projected potential?

Qo24

When a whole unit cell is treated as a single slice (projection approximation), a
A whole atomic potential will be projected.

When a unit cell is divided into a multiple slices, in principle, only the part of
potential belongs to a slice should be projected. However, xHREM will project the
whole atomic potential to the slice, which the center of atom (atom coordinate)
belongs to. In this way, we can use the projection theorem of Fourier transform to
efficiently project an atom potential.
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Image Calculation (ImageGUI)

Q‘I 01 My image does not show any contrast.

Please check an aperture radius for image calculation. The smallest fringe spacing
A that will contribute to image formation depends on the unit (s or d*), which you can
select from “Preferences” window. (Note: 2s = d*)

The smallest fringe spacing = 1/2s = 1/d*

Especially, when you have forbidden reflections, please check whether allowed
reflections are included within the aperture.

Q‘I 02 Let me know the differences between Simulation Modes.

A Simulation Mode determines the way to treat partial coherence.

Using xHREM you can choose a commonly used technique using Envelope
functions, or a more elaborate technique using Transmission Cross-coefficient
(TCC).

The technique using TCC, except a small model, requires more computation time
than the technique using Envelope functions.

When | select “First Order (Envelope)” from Simulation Mode, | can get a correct
Q1 03 image, but not with “Second order (TCC)”.

In the case of “Second order (TCC)” the spatial frequencies of twice of the objective

A aperture radius will be included in image calculation. This is because interference
terms between scattered waves that pass the objective aperture should be included
in image calculation.

Thus, “Second order (TCC)” calculation requires the Fourier space that is twice of
the aperture size, although “First Order (Envelope)” calculation requires the Fourier
space that corresponds to the aperture size. Here, image calculation uses the same
area (the same size of Fourier space) used by scattering calculation.

When the Fourier space used for image calculation is not enough, “Range”
parameter of “Dynamical calculation” pane should be increased from the
“Preferences” window of MultiGUI, and scattering calculation should be done
again. The Fourier space used for image calculation cannot be modified by changing
“Range” from the “Preferences” window of ImageGUI.

Note Except you don’t specify an exceptionally small “Range” for scattering
calculation, this situation will not occur.
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Dynamical Scattering Amplitude Output (DFOutGUI)

Why is a reflection specified using only two indexes? How can we relate these
Q201 indexes to a normal three-index system?

Multislice calculation determines scattering amplitudes using two-dimensional

A slices (Phase Gratings). Thus, a wave function calculated is two-dimensional, and
its Fourier transform is also two-dimensional. The two indexes specifies a reflection
in 2D reciprocal space.

This 2D index can be converted to a normal 3D index by finding a relation between
the 3D reciprocal lattice and the 2D reciprocal lattice. The same technique can be
used to find a relation for Higher Order Laue Zone (HOLZ).

How is the phase displayed?

Q202

A All the phases are shifted by —s/2, and thus the phase of scattered wave from a

thin sample corresponds to the phase of crystallographic structure factor (the phase
of the incident wave is displayed as —s/2).

In crystallography the phase of structure factor is zero or s for the structure that
has a center of symmetry (Namely, the structure factor is real, and will be positive
or negative value). XHREM makes the phase of scattered wave from a thin sample
correspond to the phase of crystallographic structure factor.
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CBED Extension

Q301
A

Q302

Q303

Q304

High angle area is not displayed.

The output range of CBED pattern is specified by “Range” of “Dynamical Structure
Factor” in “Output Control” pane. Please check the unit (s ot d*) and the specified
output value.

Does HOLZ lines appear under the projection approximation?

Yes, HOLZ lines will appear close to the correct positions even under the projection
approximation. However, their intensities may not be accurate.

Can we calculate a Large-angle CBED (LACBED, Tanaka pattern)?

In LACBED experiment, a sample is placed off the electron beam focus point. Then,
only the transmitted beam selected by an aperture is recorded.

Since xHREM calculates a CBED pattern by creating the focused probe at the
specimen entrance surface, LACBED cannot be obtained.

How can we improve HOLZ line accuracy?

In order to get a fine HOLZ line, use a higher “Resolution” of “Calculation Control”
of the CBED dialog. Please consult the CBED Manual for a calculation step for each
resolution setting.

In order to obtain a CBED pattern with an accurate position and intensity of HOLZ
lines, the 3D effect (see Q019) should be properly included. Thus, a unit cell should
be divided into a multiple slices.
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STEM Extension

Q401
A

Q402

Q403

An output from STEM image does not seem to represent a model structure.

At first, check a projected model structure using Model Viewer (Model View of
MultiGUI). If the projected model is displayed correctly, then check a scan step. If
the scan step is larger than 0.3 A, you may not get a smoothed atomic structure.

NOTE: If a displayed projected model structure is not correct, even when input atom
parameters and a selected space group are right, then the symmetry operations of
the selected space group may be wrong. If you find such an error, please report
your finding to our support.

How to select a super-cell size?

The size of a super-cell determines a sampling interval of Fourier space (an inverse
of super-cell size corresponds to a calculation step of scattering distribution).
Therefore, a super-cell size of larger than 5 nm (scattering calculation step of less
than 0.2 /nm) should be employed for a good simulation.

1. Crystal model

If a unit cell of the model is less than 5 nm, select “Standard” from “Super-cell size.”
Then, the input unit cell will be automatically repeated to create an approximately
5-nm super-cell. If a unit cell of the model is larger than 5 nm, select a size of super-
cell larger than the unit cell.

2. Interface or a defect model

Select an appropriate size of super-cell that is larger than the longer edge of the
structure model. Other short direction will be automatically repeated to fill the
selected super-cell.

3. Model with no periodicity, such as a nano-particle

Select an appropriate size of super-cell that can accommodate the whole model.

Computation becomes extremely slow, when a model size becomes large.

STEM calculation requires all the phase gratings at each scan point. Therefore, even
when a part of phase gratings cannot be loaded into the mail memory (RAM), all
the phase gratings should be read from an external memory for each scan points in
the case of a large model. Since computation speed of a contemporary PC is
astonishingly fast, a total computation time will be extremely deteriorated due to
this data access.

To avoid this defect you have to install more RAM. If the total size of phase gratings
becomes more than about 2GM, you may have to use the 64-bit version (STEM
Extension Pro) that supports a 64-bit OS to handle more memory.
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What is a range to be included for scattering calculation? Does this range depend

Q404 on the model size?

In order to evaluate probe propagation under elastic scattering, calculation including
A s=2.5/A (d*=5.0/A) is normally sufficient. This range does not depend on the model
size.

What is a strategy to shorten computation time?

Q405

Since STEM simulation requires scattering calculation at each scan point, a total

A computation time tends to become very long. The current version of STEM
Extension supports Multi-Core CPU. Thus, if you use a PC with a multi-CPU, you
can reduce a total computation time by a factor that is approximately a number of
CPU (Core).

A further reduction of computation time will be obtained, if you use a cluster version
(STEM Extension Cluster) that uses multiple computers simultaneously.

Furthermore, from v.5.0 the STEM Extension supports GPGPU (General-purpose
computing on Graphic Processing Unit) to further accelerate STEM
performance.

In the case of Windows, we support NVIDIA GPU(s) using NVIDIA CUDA
(Compute Unified Device Architecture). The latest NVIDIA GPU has 10-20 times
computing power of a multi-core CPU, and gives you the performance equivalent
to a cluster of 10-20 PCs at a low cost. Even an old GPU has computing power
equivalent to several times of a multi-core CPU, and thus corresponds to a cluster
of several PCs. In addition, our GPU module supports more than one GPU.
Furthermore, our GPU module supports the GPU other than NVIDIA using OpenCL
(Open Computing Language) (from v5.2).

In the case of macOS, our GPU module supports Apple Silicon GPU and third-party
GPGPU using OpenCL (from v5.3).
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